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Pocket InspectMate v5.1

Demo Guide

About this Guide

The purpose of this Demo Guide is the following:

1) To provide step-by-step instructions on the main features of the Knights Software Solutions Pocket
InspectMate System.

This Demo Guide has been organized into the following 2 sections:

System Overview: A brief description of various components of the system and how they relate to one
another.

Pocket InspectMate Features: Step-by-step instructions on how to enter inspection data and generate
inspection reports as well as reference material describing various screen elements.

InspectMate System Overview

General Introduction

The Knights Software “Pocket InspectMate” is designed to give inspectors the ability to
rapidly gather home inspection information directly onto a hand-held computer such as a
PocketPC device, an ultramobile PC or a TabletPC.

With version 5, the InspectMate software runs not only on a full Windows device but also on
any PocketPC device.

Knights Software “Pocket InspectMate” can accelerate the inspection reporting process. With
“Pocket InspectMate” the data is captured electronically from the start, eliminating the need to
re-key information into a personal computer back at the office.

One of the most powerful features of “Pocket InspectMate” is that it was designed to give the
user complete control over the information that is being collected and reported.  By using
“InspectMate” along with the “Library Editor”, the user can customize categories,
steps(components), material checklists, ratings, comments(boiler plates), related reference
material for each step(component) and comment pick lists used in the data collection process.
The Knights Software Inspection system can adapt to your business.

The InspectMate system is also designed to make on-site electronic reporting very feasible
and at an affordable cost.  The system is designed so that you have the option of being
completely done with your inspection when you leave the site without the need to re-key
ANY information at the office.  This is a tremendous time saver and gives the ability to print
out a professional report on site. This can dramatically increase your business.
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If you do feel it necessary to review the report before delivering it you can easily export the
inspection and then download it to your PC where you can then open the inspection document
in any current word processor like Microsoft Word.  The inspection report will come into the
word processor preformatted eliminating having to re-key any inspection information.  Once it
is in your word processor you are free to do any enhancements to the document you feel are
necessary.

The InspectMate system is designed to adapt to your business.  That is what makes Knights
Software Solutions, Inc. the premiere provider of vertical market software for hand-held
devices.

Component Overview

The Knights Software Solutions Inspection System consists of two main software
components: 1) Pocket InspectMate, which runs on a handheld device and is used to collect
data and generate reports, and 2) Library Editor, which runs on a Windows based PC and is
used to customize various aspects of InspectMate including Categories, Steps, Material
Checklists, Ratings, and the invaluable Comment Pick lists(Boiler plates). It is a “Data
Driven” system.  Simply by editing lists in Library Editor, the user can adapt InspectMate to
their way of doing inspections.

Data Model

“InspectMate” helps the user collect data for many types of inspections.  Shipped with this
product is a universal inspection type built for general residential home inspections.  It is
based on the ASHI Standards of Practice and has had input from many inspectors across the
country with many years of experience in the inspection industry.

Within every Inspection Type there can be many Categories.  In the case of the template that shipped with
the InspectMate system you will see Categories applicable to a general home inspection, such as Kitchen,
Garage, Roof, etc.

Each Category is made up of a series of Steps(components) specific to that Category.  For example, in the
Kitchen Category you will see Steps such as Floors, Walls, Ceiling, Windows, Countertops, Cabinets,
Range, Microwave, etc.

Each Step has a place for a Rating, a Checklist of materials, Step Info, Pictures and Comments.

LibraryEditor

Most of the elements found in InspectMate can be customized by adding, editing, or deleting Categories,
Steps, Ratings, and Comments using an application called LibraryEditor that runs on the PC.   Modified
templates can then be downloaded to the handheld device using Microsoft’s ActiveSync application.
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Section 1 – Pocket InspectMate

Inspection Walk-through

Setting up a new inspection

To Launch “Pocket InspectMate” turn on your handheld device. Tap the “Start” button and select from the
pull-down menu the “Pocket InspectMate” icon using the stylus.

To create a new inspection document select the "New" menu item from the "File" menu. A blank
Inspection Setup screen will appear. (Shown on next page)  Use the pen or keyboard to enter general
information about the inspection such as Dwelling Address, Realtor, Agency, Client Name, etc.

(Note – to enter data into a specific field, tap once on the field to place the cursor in that field, then type or write the
information you wish to store in that field)
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Select the “Next Page >>” button to go to the second page of the Inspection Setup section.

Notice that some fields have a button with a black triangle next to them.  This button indicates a popup list
associated with the field for quick entry of common data.  You can add your own items to these pick lists.

One of the most important items to complete on the Inspection Setup Screen is the Document Type field.
Other fields may be left blank but you must pick a Document Type from the pick list so that Pocket
InspectMate will know which category, step, and comment templates will be used for this inspection.

Before proceeding to enter the actual inspection data please make sure that an actual document type has
been selected in the DocType Field dropdown list like “Buyers Inspection” or “General Home Inspection”.
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Choosing a category to inspect

To enter the actual Inspection Data, you first must view a list of categories available for the current
inspection.  To do this, tap the "View" menu and select “Category List”.

The Category List window (Next page) will appear.
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Step List Window

Tap the first category “Property Information” or “General Info” to view its corresponding Step
List (Diagram below). Make sure to tap on the actual name of the Category and not the circle in
front of the category name.

The Step List window has a list of all the Steps/Components for the Category you tapped on.  The window
consists of 2 columns of data for each Step: 1)Step Title,  and 2)Rating.



Demo Guide Knights Software Solutions Page - 7

The Step Title column lists each Step’s number and name.  If the name is too long to fit in the column it
will have three ellipses (…) at the end.

The Rating column consists of a drop down list of each Step's rating choices. These drop-down lists may
be different for each Step. Some may have a "Yes, No" choice and others may have the normal "Functional,
Marginal, Hazardous" Rating.  Some Steps may have no Rating choices at all.  These ratings are all user-
definable in LibraryEditor and are discussed in more details in the manual.

On the top of the window is the current Category you are in along with the current inspection dwelling
address.

Double-tap on the first Step title “Main Entry Faces” column to bring up the Step Detail window with it
defaulting to the “Materials” tab.

When you double-tap on the “Main Entry Faces” Step you should see a list of checkboxes for the Step as
seen below.

Select the appropriate checkbox and then select the “>>” button to proceed to the next Step. Continue to
check the appropriate checkboxes for each Step and then select the “>>” button. Once the “>>” becomes
gray it is the last Step for this Category. Select the “OK” button to close the Step Detail window and then
select the “To Categories” button to go back to the list of Categories screen. You can then select another
Category and proceed with the same actions to enter data for each inspection item.
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Entering Inspection Data

The process of entering inspection data is organized by category.  For every category there are a number of
steps where the heart of your inspection data is entered. You can have an Inspection Step for every item
you wish to inspect. (Refer to LibraryEditor for how to add, change, or delete Inspection Steps, Categories,
and Inspection Types.)  There is no limit to how many Steps you can have in a particular Category.  If there
are more Steps then can fit on the screen then the scroll bars become active.

The InspectMate system gives you four ways to capture information for each inspection step: 1) a rating
pick list, 2) a checklist of materials, 3) free-form Comments/Boilerplates and      4) pictures and diagrams.

In the Step Detail window it is very easy to switch to the other 3 Step detail views by tapping one of the
other tabs.  To see the Step Info available for the "Walkways" Step you would tap the "Materials" tab.  If
you wanted to see all the Comments for the "Walkways" Step you would select the "Comments" tab.

We will walk through entering some inspection data now.

1) Select the “Kitchen” Category in the Category List by tapping on its name.
2) Double-tap on the “Sink/Faucet” Step in the Step List.
3) Select the “Materials” tab and then select the “spray hose” material as shown below.

Material Comments – InspectMate has a special feature that allows a comment to be linked to a particular
material choice for a given step.  This is called a material comment. For example, whenever you check
“asphalt” for a driveway you may want a comment about annual top coating to automatically appear for
that Step.  Another example may be for a comment warning for whenever EIFS type siding is encountered.
An asterisk indicates a material has an associated comment attached.
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4) Select the “S-trap*” material and then select the “Comments” tab and you will see an associated
Comment is inserted automatically. (See below)

Entering Comments – Knights Software has made over a thousand common comments available through
the comment pick lists.  Tap the pick list drop down box (indicated by a small triangle) to view a list of
common comments.  Just pick the appropriate comment from the list.  Repeat this procedure to enter
multiple comments from the list.
5) Tap the cursor at the end of the current comment text and then select “Faucet drips” from the Comments
drop down. It should get added to the end of the comment text.
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Fill-in-the-Blank Comments – Some comments may contain an insertion caret ("^").  When a comment
containing this caret is picked the user will be prompted to supply information to “fill-in-the-blank” for that
comment.
Picker List items - You can also have another picker list inside one of your comments.  An example could
be "Limited review due to ^pReview^." where the "pReview" List item has the following list items
(“snow”, “junk”, “boxes”, “furniture”).  This makes it possible to pick one of these choices to fill in the
blank instead of writing or typing it in.

6) Select from the Comment drop down list the “Leak noted at ^pLeak3^.” comment. When it is selected
another dialog will come up with a drop-down list of words/phrases to finish the comment. Select the
“drain line/trap” choice and select the “OK” button.

Resulting Comment text area.
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Using the Comment Multi-Picker - You can also add multiple comments at once by selecting the "Multi-
Picker…" button. This will bring up the Comment Multi-Picker dialog (shown below) that has a selectable
scrollable list of all the comments for the current Step. An order number will appear before each comment
that is selected.  You can change the order by selecting an already selected comment and the it will be
removed and the order of the remaining comments are updated appropriately. Tapping the "OK" button will
close the Multi-Picker dialog and insert into the corresponding Step's text area the selected comments in the
order they were designated.  Any comments with insertion carets ("^") will bring up the "Enter Insertion
Text" dialog for each comment.

7) Select the “>>” button to go to the next item in your inspection. Select it again to proceed to the
“Dishwasher” Step.
8) Select the “++” button to the right of the Comment drop down menu and the Multi-Picker Dialog will
come up.
9) Select the “Deteriorated seal.” Followed by the “Not Properly installed/secured.” Comment and select
the OK button. The comments will be in the Comment area now.

Apply Defaults –Knights Software has provided a feature that allows you to apply material defaults by just
tapping the “Apply Defaults” button on the Step Detail dialog.  Any Step with a default material will get
checked automatically and can help in speeding up the inspection process.  These default Materials are set
in LibraryEditor.

Entering Pictures and Diagrams – One of the time consuming operations for a home inspector if they are
using pictures in their report is placing their pictures into their report at the end of the inspection process.
Having to meticulously place each picture where they want it in the body of the report can take up to 15
minutes or more based on the number of pictures the inspector took during the inspection.
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To make this task much easier and completely automated the InspectMate application has added a
feature that lets you create picture tags embedded in the report while you are doing the actual inspection.
All the inspector has to do is when they take a picture is select a button on the Comment screen that will
insert a tag for that particular picture.  Later at the end of the inspection the media that is in the camera can
be moved to either the handheld or the PC at the office where the associated pictures will be inserted
automatically in their appropriate places, eliminating having to do it manually.

When the “Picture #” button is selected in the Comment tab view a Picture Tag Insertion dialog
will come up and will default to the next Picture Number. (See Diagram 1.13 below) Each time the “Picture
#” button is selected the Picture Number will be incremented by one.  This number can be changed by
selecting the “+” or “-“ button.  You can also reset the Picture Number back to “1” by selecting the “Reset
Counter” button.  Selecting the “OK” button will then insert into the Comment area for this Step a Picture
Tag.

The Picture Tag will consist of a beginning tag “***” and then the actual picture counter followed
by the scaling factor. An example would be “***Picture-1;Scaling=100***”.  This is a Picture Tag for
picture 1 with a scaling of 100%.

 Insert Picture Tag dialog

10) Select the “>>” button to proceed to the “Range/Oven” Step.
11) Select the “Comments” tab and then select the “Pict#” button at the bottom of the dialog.
12) The Insert Picture Tag dialog (as above) will come up and then just select the “OK” button.
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When the picture tag is inserted into the text area for the current Step it will be replaced with the
corresponding picture when the inspection is printed.  The diagram below shows the Picture Tag inserted
into the “Range/Oven” Step.  When this inspection is printed the first picture on the camera media will be
automatically printed in the report in the appropriate Step.

13) Continue to use the “>>” button to move through the inspection items and going back to the Category
list by using the “To Categories” button to go back to the main list of Categories to get a good feel of how
to use the interface of entering inspection data.
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Printing a report

Go to the “View Menu” and tap “Inspection List”.  To print a report take the following steps:  Select or
open the inspection you wish to print.  (Note – single tap selects the inspection, a double-tap opens the
inspection.)

Once you have selected (or opened) the inspection you wish to print, go to the “File” Menu and tap
“Print…” A "Print Properties" dialog will appear (dialog below) giving you the Print Report options.

Inspection Report -By default, you can print the full inspection report.  Selecting the "Print Inspection"
radio button will print out the entire inspection with all the data you collected for the current inspection.  A
page break is inserted after every Category when you print the report.  This makes it much easier to reprint
a single Category when changes are made without having to reprint the entire report.

Continuous option - If the "Continuous" check box is checked this suppresses the page break after every
Category in the inspection report.  Each new Category and its associated Steps are printed after the
previous Category in a continuous report that makes the report shorter and a little quicker to print.  The
disadvantage of printing the continuous report is when you need to reprint a specific Category you will
need to reprint all the Categories after the correction in the report.  If each Category has a page break you
only need to reprint that one Category again.

Print Summary – Select the “Print Summary” radio button to print just the Inspection Summary Report.
This is a condensed report that only prints out the Steps and Comments that were flagged as significant and
should appear on the Summary.  This is controlled by the rating choice that is selected for each Step.  An
example could be a rating choice called "Defects" that would force the Step and any Comments for that
Step to print on the Summary report.
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Print Dialog

Once you have selected the type of report you want to print and the print options in the Print Report dialog
and have tapped the OK button the standard Print dialog will appear as shown below.

Select the appropriate printer you are printing to in the "Printer" drop down list (some examples are the
"HP PCL3 Compatible" for the portable HP 450/460 ) and then select the "Port" type you are using to print
from.  Some of the options that are available in the "Port" menu item are “Infrared”, and "Bluetooth".

Tapping the "Start Printing" button on the "Print" dialog and point the handheld device toward the printer if
you are using Infrared.

Creating a report to transfer to a PC

Select the inspection in the Inspection List window or open the inspection you wish to export and go to the
“File” Menu and tap “Export RTF…” menu item.

The "Export RTF" dialog will appear (diagram below).  You have the option of either exporting a full
Inspection Report, a Summary Report or a Major Systems report.  Select the appropriate option and tap the
"OK" button.
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You also have the ability to change the name of the report for this inspection. Change the name that appears
at the top of each page of the report by changing the “Report Name:” field. This field will default to the
name of the Doctype of the current inspection.

A standard “Save As” dialog (Diagram below) will appear giving you the opportunity to name the file and
to identify the directory the file is to be saved into. The exported document will default to a name with the
Document# in it. Most inspectors name the RTF inspection document by the document/inspection number
or by the dwelling address of where the inspection was done.

It is highly recommended saving the RTF file to an external storage card like a CF card or an SD
card.  On certain handheld devices there are built-in internal storage cards that the RTF file could be
saved to also.  This should be done before going to the next inspection.  This would create a backup of
the inspection just completed.

Tap the “OK” button to complete the export. (Note – While the document that is created can be opened
with “Pocket Word”, “Pocket Word” does not support all of the required formatting features that are part of
the document. To view the properly formatted document you must use Microsoft Word or a compatible
word processor from your PC.)

To view the document in a word processor, use Microsoft ActiveSync to transfer the document to your PC.
Refer to the ActiveSynch documentation that came with your handheld for directions on how to connect
your handheld to your PC and how to install and use Microsoft ActiveSync.

To transfer the inspection document to the PC open “My Computer” and then the "Mobile Devices" icon.
Proceed to open the "My Handheld PC" and then the storage card.  This may be named as the “Storage
Card” folder.  You should see your inspection document you just exported in the appropriate folder. You
drag this document out of this folder in the "My Handheld PC" to your PC.  I would recommend creating a
specific folder on your PC called "Inspections" to save all your inspection documents into. A progress
thermometer should come up as the document is being transferred.

Once it is done transferring over just double-click on the document on your PC and your default word
processor will automatically open the inspection document. The word processor document and all of your
inspection data will be in a preformatted report. Once it is in your word processor you can include your
digital photos or Carson Dunlop images easily and have a very professional report in minutes.


